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Introduction
The Heat Transfer Module is used by product designers, developers, and scientists, 
who use detailed geometrical descriptions to study the influence of heating and 
cooling in devices or processes. It has modeling tools for the simulation of all 
mechanisms of heat transfer including conduction, convection, and radiation. 
Simulations can be run for transient and steady conditions in 1D, 1D axisymmetric, 
2D, 2D axisymmetric, and 3D space coordinate systems.

The high level detail provided by these simulations allows for the optimization of 
design and operational conditions in devices and processes influenced by heat 
transfer.

Figure 1: Temperature and flow field in an aluminum heat sink and in cooling air that is pumped over the 
heat sink. The temperature and flow field are solved using detailed geometry and a description of the 
physics.

The Heat Transfer Module’s Model Library is a resource with examples of the heat 
transfer interfaces and the many available features. The Model Library has 
educational tutorials as well as industrial equipment and device benchmark models 
for verification and validation. 

This introduction fine tunes your COMSOL model building skills for heat transfer 
simulations. The model tutorial solves a conjugate heat transfer problem from the 
field of electronic cooling but the principles can be applied to any other field involving 
heat transfer in solids and fluids.
Introduction | 5
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Basic Concepts Described in The Heat Transfer Module
Heat is one form of energy that, similar to work, is in transit from inside a system or 
from one system to another. This energy may be stored as kinetic or potential energy 
in the atoms and molecules in a system.

Conduction is the form of heat transfer that can be described as proportional to the 
temperature gradients in a system. This is formulated mathematically by Fourier’s law. 
The Heat Transfer Module describes conduction in systems with constant thermal 
conductivity and in systems where thermal conductivity is a function of temperature 
itself or of any other model variable, for example chemical composition.

In the case of a moving fluid, the energy transported by the fluid has to be modeled 
in combination with fluid flow. This is referred to as convection of heat and has to 
be accounted for in forced and free convection (conduction and convection). This 
module includes descriptions for heat transfer in fluids and conjugate heat transfer 
(heat transfer in solids and fluids in the one system) for both laminar and turbulent 
flows. In the case of turbulent flow the module offers high-Reynolds or, alternatively, 
low-Reynolds models to accurately describe conjugate heat transfer.

Figure 2: Heat transfer in a system containing a solid and a fluid (conjugate heat transfer). In the fluid, 
heat transfer can take place through conduction and convection, while conduction is the main heat 
transfer mechanism in solids. Heat transfer by radiation can occur between surfaces in a model.

Radiation is the third mechanism for heat transfer included in the module. It is 
modeled using expressions for surface-to-ambient radiation (for example, by defining 
6 | Introduction
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boundary conditions) and also by using surface-to-surface radiation models, which 
includes external radiation sources (for example, the sun). The surface-to-surface 
radiation capabilities are based on the radiosity method. In addition, the module also 
contains functionality for radiation in participating media. This radiation model 
accounts for the absorption, emission, and scattering of radiation by the fluid present 
between radiating surfaces.

The basis of the Heat Transfer Module is the balance of energy in a studied system. 
The contributions to this energy balance originate from conduction, convection, and 
radiation but also from latent heat, Joule heating, heat sources, and heat sinks. In the 
case of moving solids, translational terms may also be included in the heat transfer 
models, for example for solids in rotating machinery. Physical properties and heat 
sources (or sinks) can be described as arbitrary expressions of the dependent 
variables in a model (for example, temperature and electric field). The heat transfer 
equations are defined automatically by the dedicated physics interfaces for heat 
transfer and fluid flow. The formulations of these equations can be visualized in detail 
for validation and verification purposes.

Physical properties such as thermal conductivity, heat capacity, density, and emissivity 
can be obtained from the built-in material library for solids and fluids and from the 
add-on Material Library in COMSOL. In addition, the module contains relations for 
the calculation of heat transfer coefficients for different types of convective heat 
transfer from a surface. For turbulent heat transfer, it also features relations that 
calculate the thermal conductivity in turbulent flow using the eddy diffusivity from 
turbulence models (sometimes referred to as turbulent conductivity).

The work flow in the module is straightforward and is described by these steps—
define the geometry, select the material to be modeled, select the type of heat 
transfer, define the boundary and initial conditions, define the finite element mesh, 
select a solver, and visualize the results. All these steps are accessed from the 
COMSOL Desktop. The mesh and solver steps are often automatically completed 
with the default settings, which are already tuned for each type of heat transfer 
interface.

The Applications
Heat transfer is present in most physical processes and phenomena, either as a side 
effect or as a desired effect. The module can be effectively used to study a variety of 
processes, for example to include building ventilation effects, to account for turbulent 
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free convection and heat transfer, and to analyze the impact of electronic 
microdevice heat generation and cooling.

The Heat Transfer Module’s Model Library contains tutorial and benchmark models 
from different engineering fields and applications. See “Opening the Model Library” 
to find out how to access the models.

The Electronics and Power Systems section in the Model Library includes models that 
often involve heat generation and heat transfer in solids and conjugate heat transfer, 
where cooling is described in greater detail. The models in these applications are 
often used to design cooling systems and control the operating conditions of 
electronic devices and power systems. When the model results are interpreted, it 
provides the tools needed to understand and optimize the flow and heat transfer 
mechanisms in these systems.

Figure 3: Temperature field as a result of conjugate heat transfer in a benchmark model for electronics 
cooling. This plot is from the model Convection Cooling of Circuit Boards—3D Forced Convection. 

The Process and Manufacturing section in the Model Library has examples including 
thermal processing of materials and phase change processes such as continuous 
casting and friction stir welding. The common feature with these models is that the 
temperature field and the temperature variations have a very large impact on the 
material properties of the modeled processes and devices. The highly nonlinear 
behavior of the material properties as a function of temperature, combined with the 
8 | Introduction
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high temperatures that implies accounting for radiation, make these processes 
difficult to predict and understand. Modeling and simulation often provide a shortcut 
to this understanding, which is required to design and operate a system.

Figure 4: Temperature field plot from the Continuous Casting model. A sharp temperature gradient is 
found across the mushy layer, where the liquid metal solidifies.

The Medical Technology section in the Model Library introduces the concept of 
bioheating, where the influence of various processes in living tissue are accounted for 
as contributing to heat flux and as sources and sinks in the heat balance. The types 
of bioheating applications modeled include hyper thermia cancer therapy, such as 
microwave heating of tumors, and the interaction between microwave antennas and 
living tissue, for example, the influence of cellphone use to the temperature of tissue 
close to the ear. The benefit of using the bioheat equation is that it has been validated 
for different types of living tissue using empirical data for the different properties, 
sources, and sinks. The models and simulations defined in this interface provide 
excellent complements to experimental and clinical trials, which may be used, for 
example, to develop new methods for dose planning.

Opening the Model Library
To open a Heat Transfer Module Model Library model, select View > Model Library  
from the main menu in COMSOL Multiphysics. In the Model Library window that 
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heat_introduction.book  Page 10  Monday, April 23, 2012  6:32 PM
opens, expand the Heat Transfer Module folder and browse or search the contents. 
Click Open Model and PDF to open the model in COMSOL Multiphysics and a PDF to 
read background theory about the model including the step-by-step instructions to 
build it.

The MPH-files in the COMSOL model libraries can have two formats—Full MPH-files 
or Compact MPH-files.

• Full MPH-files, including all meshes and solutions. In the Model Library these 
models appear with the  icon. If the MPH-file’s size exceeds 25MB, a tip with 
the text “Large file” and the file size appears when you position the cursor at the 
model’s node in the Model Library tree.

• Compact MPH-files with all settings for the model but without built meshes and 
solution data to save space on the DVD (a few MPH-files have no solutions for 
other reasons). You can open these models to study the settings and to mesh and 
re-solve the models. It is also possible to download the full versions—with meshes 
and solutions—of most of these models through Model Library Update. In the 
Model Library these models appear with the  icon. If you position the cursor 
at a compact model in the Model Library window, a No solutions stored message 
appears. If a full MPH-file is available for download, the corresponding node’s 
context menu includes a Model Library Update item.

A model from the Model Library is used as a tutorial in this guide. See “Tutorial 
Example—Heat Sink” star ting on page 15. The next section describes the available 
interfaces in this module.

The Heat Transfer Module Interfaces
The figure below shows the Heat Transfer interfaces included in the Heat Transfer 
Module. These physics interfaces describe different heat transfer mechanisms and 
also include predefined expressions for sources and sinks. The Heat Transfer 
10 | Introduction
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interfaces are available in 1D, 2D, 2D axisymmetric, 3D, and for stationary and 
time-dependent analyses.

H E A T  TR A N S F E R

The Heat Transfer in Solids interface ( ) describes, by default, heat transfer by 
conduction. It is also able to account for heat flux due to translation in solids, for 
example, the rotation of a disk or the linear translation of a shaft.

The Heat Transfer in Fluids interface ( ) accounts for conduction and convection 
in gases and liquids as the default heat transfer mechanisms. The coupling to the flow 
field in the convection term may be entered manually in the user interface or it may 
be selected from a list that couples heat transfer to an existing fluid flow interface. 
The Heat Transfer in Fluids interface may be used when the flow field has already 
been calculated and the heat transfer problem is added afterwards, typically for 
simulations of forced convection. 

The Heat Transfer in Porous Media interface ( ) combines conduction in a porous 
matrix and in the fluid contained in the pore structure with the convection of heat 
generated by the flow of the fluid. This physics interface provides a power law or 
user-defined expression for the effective heat transfer properties and a predefined 
expression for dispersion in porous media. Dispersion is caused by the tor tuous path 
of the liquid in the porous media, which would not be described if only the mean 
convective term was taken into account. This interface may be used for a wide range 
of porous materials, from porous structures in the pulp and paper industry to the 
simulation of heat transfer in soil and rock.
Introduction | 11
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The Bioheat Transfer interface ( ) is a dedicated interface for heat transfer in living 
tissue. The bioheat model described in this interface has been verified for different 
types of living tissue, where also empirical data is available for physical properties, 
sources, and sinks. Apart from data such as thermal conductivity, heat capacity, and 
density, tabulated data is also available for blood perfusion rates and metabolic heat 
sources.

The Heat Transfer in Shells interface ( ) contains descriptions for heat transfer 
where large temperature variations may be present in a 3D structure but where the 
temperature differences across the thickness of the material of the structure are 
negligible. Typical examples may be structures like tanks, pipes, heat exchangers, 
airplane fuselages, and so forth. This physics interface can be combined with other 
heat transfer interfaces, for example to model the walls of a tank using the Heat 
Transfer in Thin Shells interface while the Heat Transfer in Fluids feature may be used 
to model the fluid inside the tank. In many cases using the Highly Conductive Layer 
boundary condition is the easiest solution.

C O N J U G A T E  H E A T  TR A N S F E R

The Conjugate Heat Transfer interfaces ( ) describe heat transfer in solids and 
fluids and nonisothermal flow in the fluid. The heat transfer process is tightly coupled 
with the fluid flow problem and the physics interfaces include features for describing 
heat transfer in free and forced convection, including pressure work and viscous 
heating. These physics interfaces are available for laminar and turbulent 
nonisothermal flow. For highly accurate simulations of heat transfer between a solid 
and a fluid in the turbulent flow regime, low-Reynolds turbulence models resolve the 
temperature field in the fluid all the way to the solid wall in the Turbulent Flow, 
Low-Re k- interface ( ). The standard k- turbulence model in the Turbulent Flow, 
k- interface ( ) is computationally inexpensive compared to the other turbulent 
models but also usually less accurate.

If you also have the CFD Module, two additional turbulent models are available. For 
less computationally expensive simulations, where wall heat transfer is less important, 
the k- turbulence model gives good accuracy at a comparably low cost. The 
Spalar t-Allmaras interface is a dedicated interface for conjugate heat transfer in 
aerodynamics, for example for the simulation of wing profiles. 

R A D I A T I O N

The Heat Transfer interface for radiation belong to essentially two different groups 
of radiation modeling interfaces: the surface-to-surface radiation and the radiation in 
12 | Introduction
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participating media interfaces. The Heat Transfer with Surface-to-Surface Radiation 
interface ( ) combines heat transfer in fluid or solids including conduction and 
convection with surface-to-surface radiation. The Heat Transfer with Radiation in 
Participating Media interface ( ) combines heat transfer by conduction and 
convection in solids and fluids with radiation where absorption or emission of 
radiation is taken into account by the radiation model. In addition the 
Surface-to-Surface Radiation interface ( ) describes systems where only radiation 
is computed, typically to estimate radiation between surfaces in space applications 
where the surface temperature is known. The corresponding Radiation in 
Participating Media interface ( ) computes the radiation, including absorption and 
emission effects, in a media where the temperature is known.

E L E C T R O M A G N E T I C  H E A T I N G

The Joule Heating interface ( ) is a multiphysics interface that couples electric 
heating and current conduction in electric conductors with heat transfer for 
modeling of Joule heating (resistive heating). This multiphysics interface includes the 
features from the Heat Transfer in Solids interface with the Electric Current interface 
including predefined couplings for Joule heating.

Physics List by Space Dimension and Study Type
The table lists the physics interfaces available with this module in addition to those 
included with the COMSOL basic license. 

PHYSICS ICON TAG SPACE DIMENSION PRESET STUDIES

 Fluid Flow

 Single-Phase Flow

Single-Phase Flow, Laminar Flow* spf 3D, 2D, 2D 
axisymmetric

stationary; time dependent

Turbulent Flow, k- spf 3D, 2D, 2D 
axisymmetric

stationary; time dependent

Turbulent Flow, Low Re k- spf 3D, 2D, 2D 
axisymmetric

stationary with initialization; 
transient with initialization

 Non-Isothermal Flow

Laminar Flow nitf 3D, 2D, 2D 
axisymmetric

stationary; time dependent

Turbulent Flow, k- nitf 3D, 2D, 2D 
axisymmetric

stationary; time dependent
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The next section star ts the tutorial using the Heat Sink model from the Model 
Library.

Turbulent Flow, Low Re k- nitf 3D, 2D, 2D 
axisymmetric

stationary with initialization; 
transient with initialization

  Heat Transfer

Heat Transfer in Solids* ht all dimensions stationary; time dependent

Heat Transfer in Fluids* ht all dimensions stationary; time dependent

Heat Transfer in Porous Media ht all dimensions stationary; time dependent

Bioheat Transfer ht all dimensions stationary; time dependent

Heat Transfer in Thin Shells htsh 3D stationary; time dependent

 Conjugate Heat Transfer

Laminar Flow nitf 3D, 2D, 2D 
axisymmetric

stationary; time dependent

Turbulent Flow, k-  nitf 3D, 2D, 2D 
axisymmetric

stationary; time dependent

Turbulent Flow, Low Re k-  nitf 3D, 2D, 2D 
axisymmetric

stationary with initialization; 
transient with initialization

 Radiation 

Heat Transfer with Surface-to-Surface 
Radiation

ht all dimensions stationary; time dependent

Heat Transfer with Radiation in 
Participating Media 

ht 3D, 2D stationary; time dependent

Surface-to-Surface Radiation rad all dimensions stationary; time dependent

Radiation in Participating Media rpm 3D, 2D stationary; time dependent

 Electromagnetic Heating

Joule Heating* jh all dimensions stationary; time dependent

* This is an enhanced interface, which is included with the base COMSOL package but has added 
functionality for this module.

PHYSICS ICON TAG SPACE DIMENSION PRESET STUDIES
14 | Introduction
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Tutorial Example—Heat Sink
This model is an introduction to simulations of fluid flow and conjugate heat transfer. 
It demonstrates the following important points. How to:

• Draw an air box around a device in order to model convective cooling in the box.

• Set a total heat source on a domain using automatic volume computation.

• Model the temperature difference between two surfaces in the presence of a thin 
thermally resistive layer.

• Include the radiative heat transfer between surfaces in a model.

• Display results in an efficient way using selections in data sets.

The modeled system consists of an aluminum heat sink for the cooling of an 
electronic component. See Figure 5

Figure 5: Heat sink and electronic component geometry

The heat sink is mounted inside a channel of rectangular cross section (see Figure 5). 
Such a set-up is used to measure the cooling capacity of heat sinks. Air enters the 
channel at the inlet and exits the channel at the outlet. To improve the thermal 
contact between the base surface of the heat sink and the top surface of the 
electronic component, thermal grease is used. All other external faces are thermally 
insulated. The heat dissipated by the electronic component is equal to 1W and is 
distributed in all the component volume.

The cooling capacity of the heat sink can be determined by monitoring the 
temperature in the electronic component.
Tutorial Example—Heat Sink | 15
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The model solves a thermal balance for the electronic component, the heat sink, and 
the air flowing in the rectangular channel. Thermal energy is transported through 
conduction in the electronic component and the aluminum heat sink. The 
temperature field is discontinuous at the interface between the electronic 
component and the heat sink due to the presence of a thin resistive layer (thermal 
grease). Thermal energy is transported through conduction and convection in the 
cooling air. The temperature field is continuous across the internal surfaces between 
the heat sink and the air in the channel. The temperature is set at the inlet of the 
channel. A total power of 1 W is dissipated in the electronic component. The 
transport of thermal energy at the outlet is dominated by convection.

In the first step of the model, heat transfer by radiation between surfaces has been 
neglected. This assumption is valid as the surfaces have low emissivity (close to 0), 
which is usually the case for polished metals. When the surface emissivity is large 
(close to 1), the surface-to-surface radiation should then be considered. This is done 
in the second step of this tutorial. The model is modified to account for 
surface-to-surface radiation at the channel and heat sink boundaries. Assuming that 
the surfaces have been treated with black paint, the surface emissivity is close to 1 in 
this second case.

The flow field is obtained by solving one momentum balance for each space 
coordinate (x, y, and z) and a mass balance. The inlet velocity is defined by a parabolic 
velocity profile for fully developed laminar flow. At the outlet, a constant pressure is 
combined with the assumption that there are no viscous stresses in the direction 
perpendicular to the outlet. At all solid surfaces, the velocity is set to zero in all three 
spatial directions.

The thermal conductivity of air, the heat capacity of air, and the air density are all 
temperature-dependent material properties. You can find all of the settings 
mentioned in the physics interface for Conjugate Heat Transfer in COMSOL 
Multiphysics. You also find the material properties, including their temperature 
dependence, in the Material Browser.
16 | Tutorial Example—Heat Sink
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Results
In Figure 6, the hot wake behind the heat sink is a sign of the convective cooling 
effects. The maximum temperature, reached in the electronic component, is slightly 
more than 382 K. 

Figure 6: The surface plot shows the temperature field on the channel walls and the heat sink surface, 
while the arrow plot shows the flow velocity field around the heat sink. 

In the second step, the temperature and velocity fields are obtained when 
surface-to-surface radiation is included and the surface emissivities are large. Figure 7 
shows that the maximum temperature, slightly more than 360K, is decreased by 
Tutorial Example—Heat Sink | 17
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about 22K compared to the first case in Figure 6. This confirms that radiative heat 
transfer is not negligible. 

Figure 7: Effects of surface-to-surface radiation on temperature and velocity fields. The surface plot 
shows the temperature field on the channel walls and the heat sink surface, while the arrow plot shows 
the flow velocity field around the heat sink. 

MODEL WIZARD

1 Open COMSOL Multiphysics. In the Model Wizard window the Space Dimension defaults 
to 3D. Click Next .

2 In the Add physics tree under Heat Transfer>Conjugate Heat Transfer , double-click 
Laminar Flow (nitf)  to add it to the Selected physics list. Click Next .

3 In the Studies tree, under Preset Studies select Stationary . 

4 Click Finish .
18 | Tutorial Example—Heat Sink
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GLOBAL DEFINITIONS - PARAMETERS

In this section, some parameters are defined that are used to specify the channel 
dimensions.

1 In the Model Builder, right-click Global Definitions  and choose Parameters .

2 Go to the Parameters settings window. In the Parameters table enter the following 
settings as in the figure.

GEOMETRY 1

The geometry is built in three steps. First, the heat sink geometry is imported from 
a file. Then a block representing the chip is defined below the heat sink. Finally a 
volume representing the air channel is added.

Import 1 
1 In the Model Builder, right-click Geometry 1  

and choose Import .

2 Go to the Import settings window and click 
Browse.

3 Navigate to your COMSOL Multiphysics 
installation folder, locate the subfolder 
Heat_Transfer_Module\Tutorial_Models, and 
select heat_sink_n19.mphbin

Note: The exact location of the files used in this 
exercise vary based on the installation. For example, if the installation is on your hard 
drive, the file path might be similar to C:\Program Files\COMSOL43\models\
Tutorial Example—Heat Sink | 19
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4 Click Import. 

Now define a work plane containing the bottom surface of the heat sink to draw the 
imprints of the chip and of the air channel.

Work Plane 1
1 In the Model Builder, right-click Geometry 1  

and choose Work Plane .

2 In the Work Plane settings window, locate the 
Work Plane section.

3 From the Plane type list, choose Face parallel.

4 On the object imp1, select Boundary 32 that 
corresponds to the face at the centre of the 
bottom side of the heat sink. 

Boundary 32
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Square 1
1 In the Model Builder, under Model 1>Geometry 1>Work Plane 1 right-click Plane Geometry 

 and choose Square .

2 In the Square settings window, locate the Size 
section. In the Side length field, enter L_chip.

3 Under Position from the Base list, choose 
Center.

4 Click the Zoom Extents button  on the 
Graphics toolbar.

Rectangle 1
1 In the Model Builder, right-click Plane 

Geometry and choose Rectangle .

2 In the Rectangle settings window, under Size:

- In the Width field, enter L_channel.

- In the Height field, enter W_channel.

3 In the Rectangle settings window under 
Position:

- In the xw edit field, enter -45[mm].

- In the yw edit field, enter -W_channel/2.

Now extrude the chip imprint to define the 
chip volume.

Extrude 1
1 In the Model Builder, right-click Geometry 1  and choose Extrude .
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2 Remove the object wp1.r1 from the default 
selection so that only wp1.sq1 remains in the 
Input objects list in the Extrude settings 
window under General.

3 In the Extrude settings window, under 
Distances from Plane enter H_chip in the table.

To finish the geometry extrude the channel 
imprint wp1.r1 in the opposite direction to 
define the air volume.

Extrude 2
1 In the Model Builder, right-click Geometry 1  

and choose Extrude .

2 In the Extrude settings window, under 
Distances from Plane enter H_channel in the 
table

3 Select the Reverse direction check box. 

In order to simplify the geometry and to improve the mesh that will be generated 
later, you now form composite faces. To facilitate face selection, use the wireframe 
rendering option.

Form Composite Faces 1
1 On the Graphics toolbar, click the Go to Default 3D View button  and then the 

WireFrame Rendering button .

2 In the Model Builder, right-click Geometry 1  and choose Virtual Operations>Form 
Composite Faces .

3 On the object fin, select Boundaries 15–17, 
36, 41, 44, 120, 123, and 125 only. 

Note: There are many ways to select 
geometric entities. When you know the 
domain to add, such as in this exercise, you 
can click the Paste Selection button  and 
enter the information in the Selection field. For 
more information about selecting geometric 
entities in the Graphics window, see the 
COMSOL Multiphysics User’s Guide.
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This selection is shown in this figure: 

Form Composite Faces 2
1 In the Model Builder, right-click Geometry 1  and choose Virtual Operations>Form 

Composite Faces .

2 In the object cmf1, select Boundaries 8, 9, 13, 32, 39, 113, 116, and 117 only. This 
selection is shown in this figure: 
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The final node sequence under Geometry should match this figure.

MATERIALS

Air and Aluminum 3003-H18
1 From the main menu, select View>Material Browser .
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2 In the Material Browser window in the 
Materials tree under Built-In, right-click Air 
and choose Add Material to Model . 

By default, the first material added applies to 
all domains. Typically, you can leave this 
setting and add other materials that override 
the default material where applicable. In this 
example, specify aluminum for Domain 2.

3 Go to the Material Browser window.

4 In the Materials tree under Built-In, right-click Aluminum 3003-H18 and choose Add 
Material to Model .

5 In the Model Builder, click Aluminum 3003-H18 . 

6 In the Graphics window, select Domain 2 only and add it to the Selection list.

Silica Glass
1 Go to the Material Browser. In the Materials tree under Built-In, right-click Silica glass and 

choose Add Material to Model .

2 In the Model Builder, click Silica glass .

3 Select Domain 3 only.

Thermal Grease
1 In the Model Builder, right-click Materials and choose Material .

2 In the Material settings window, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Boundary. Select Boundary 34 only.

4 Right-click Material 4 and choose Rename (or press F2). Enter Thermal Grease in the 
New name field. Click OK.
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5 In the Material settings window, click to 
expand the Material Properties section.

6 In the Material properties tree, select Basic 
Properties>Thermal Conductivity.

7 Click the Add to Material button  under 
the table.

8 Under the Material Contents section, in 
the table, enter the following settings:

The final node sequence under Materials should match this figure.

CONJUGATE HEAT TRANSFER (NITF)

Now define the physical properties of the model. Star t by adding a Fluid feature to 
define the fluid domain.

Fluid 1
1 In the Model Builder, right-click Conjugate Heat Transfer (nitf)  and choose Fluid .

2 In the Fluid settings window select Domain 1 only.

Next use the power parameter to define the total heat source equal in the electronic 
package.
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Heat Source 1
1 In the Model Builder, right-click Conjugate Heat Transfer  and choose the domain setting 

Heat Transfer in Solids>Heat Source .

2 In the Heat Source settings window, under Domain Selection, select Domain 3 only.

3 Under the Heat Source section, click the Total power button. In the Ptot field, enter 
P_tot.

For the default Wall node, No slip is the default boundary condition for the fluid. 
Define the inlet and outlet conditions as described below.
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Inlet 1
1 In the Model Builder, right-click Conjugate Heat 

Transfer (nitf)  and choose the boundary 
condition Laminar Flow>Inlet .

2 In the Inlet settings window, select Boundary 
121 only.

3 Under Boundary Condition from the Boundary 
condition list, select Laminar inflow.

4 Under Laminar Inflow in the Uav field, enter U0.

Outlet 1
1 In the Model Builder, right-click Conjugate Heat Transfer (nitf)  and choose the 

boundary condition Laminar Flow>Outlet . 

2 Click the Zoom Extents button  on the Graphics toolbar.

3 In the Outlet settings window select Boundary 1 only.

The node sequence in the Model Builder should match 
this figure so far. The ‘D’ in the upper left corner of a 
node means it is a default node.

Thermal insulation is the default boundary condition for the temperature. Define the 
inlet temperature and the outlet condition.
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Temperature 1
1 In the Model Builder, right-click Conjugate Heat Transfer (nitf)  and from the boundary 

level choose Heat Transfer in Solids>Temperature .

2 In the Temperature settings window select Boundary 121 only.

3 Under the Temperature section in the T0 field, enter T0.

Outflow 1
1 In the Model Builder, right-click Conjugate Heat Transfer (nitf)  and choose the 

boundary condition Heat Transfer>Outflow .

2 In the Outflow settings window select Boundary 1 only.

Thin Thermally Resistive Layer 1
1 In the Model Builder, right-click Conjugate Heat Transfer (nitf)  and choose the 

boundary condition Heat Transfer in Solids>Thin Thermally Resistive Layer .

2 In the Thin Thermally Resistive Layer settings window select Boundary 34 only.
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3 Under Thin Thermally Resistive Layer in the ds field, enter 50[um].

The node sequence in the Model Builder under 
Conjugate Heat Transfer should match the figure. 

MESH 1

Free Tetrahedral 1 and Size
1 In the Model Builder under Model 1 (mod1), click Mesh 1 . 

2 Go to the Mesh settings window. Under Mesh Settings from the Element Size list, select 
Coarser.

3 Click the Build All button .

To get a better view of the mesh, suppress some of the boundaries. 
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4 In the Graphics window, select Boundaries 1, 2, and 4 only. Click the Hide Selected 
button   on the toolbar. The mesh is generated and displayed as shown in the figure 
below.

STUDY 1

1 In the Model Builder, right-click Study 1  and choose Compute . 

Two default plots are generated automatically. The first one shows the velocity 
magnitude on five parallel slices. The second one shows the temperature on the wall 
boundaries. Add an arrow plot to visualize the velocity field.
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RESULTS

Temperature (nitf)
1 Under Results right-click Temperature (nitf)  and choose Arrow Volume .

2 Go to the Arrow Volume settings window. Under Data from the Data set list, select 
Solution 1.

3 In the upper-right corner of the Expression 
section, click Replace Expression . 

4 From the menu, choose Conjugate Heat Transfer 
(Laminar Flow)>Velocity field (u,v,w). (Or enter u, 
v, and w in the fields).

5 Under Arrow Positioning:

- In the x grid points Points field, enter 20.

- In the y grid points Points field, enter 10.

- In the z grid points subsection from the Entry 
method list, select Coordinates.

- In the Coordinates field, enter 5e-3 or 5[mm].

6 In the Model Builder, right-click Arrow Volume 1  
and choose Color Expression .

7 Go to the Color Expression settings window. In 
the upper-right corner of the Expression 
section, click Replace Expression . 

8 From the menu, choose Conjugate Heat Transfer 
(Laminar Flow)>Velocity magnitude (nitf.U) (or 
enter nitf.U in the Expression field).

9 Click the Plot button .

The plot in Figure 6 on page 17 is displayed in 
the Graphics window.
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Adding Surface-to-Surface Radiation Effects
Now modify the model to include surface-to-surface radiation effects. First you need 
to enable surface to surface property in the physics interface.

In this second part we modify and solve again the model to study the effects of 
surface to surface radiation between the heat sink and the channel walls. Y

CONJUGATE HEAT TRANSFER

You can continue using the model built so far, or you can open the model from the 
Model Library.

1 To open the model in the Model Library, select View>Model Library. Under the Heat 
Transfer Module>Tutorial Models folder, click heat_sink and click Open.

2 In the Model Builder, under Model 1 click Conjugate Heat Transfer .

3 In the Conjugate Heat Transfer settings 
window, under the Physical Model section, 
click to select the Surface-to-surface 
radiation check box. 

Now it is possible to add surface to surface 
boundary condition to the model.

Surface-to-Surface Radiation 1
1 Right-click Conjugate Heat Transfer  and choose 

the boundary condition Surface-to-Surface 
Radiation>Surface-to-Surface Radiation . A 
Surface-to-Surface Radiation node with a second 
default Initial Values node is added to the Model 
Builder.

2 In the Model Builder, click the Surface-to-Surface 
Radiation 1 node .

3 Select Boundaries 6,7,9–30,36–109, and 111–120 
only. 
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4 In the Surface-to-Surface Radiation settings window, under Surface Emissivity, from the  
list, choose User defined. In the field, enter 0.85.

By default the radiation direction is controlled by the opacity of the domains. Next 
define the opaque parts of the model.

Opaque 1
1 In the Model Builder, right-click the Heat Transfer in Solids 1 node and choose Opaque.

Surface-to-Surface Radiation 2
1 Add another Surface-to-Surface Radiation node. In the Model Builder, right-click Conjugate 

Heat Transfer  and choose the boundary condition Surface-to-Surface 
Radiation>Surface-to-Surface Radiation .

2 Select Boundaries 2–5 only.

3 In the Surface-to-Surface Radiation settings window, under Surface Emissivity from the  
list, choose User defined. In the field, enter 0.9.

4 Under Radiation Settings, from the 
Radiation direction list, choose Negative 
normal direction.

5 Highlight boundaries 1, 2, and 4. Click the 
Hide Selected button   on the toolbar. 

MODEL WIZARD

In order to keep the previous solution and to be able to compare it with this version 
of the model, add a second stationary study. 
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1 In the Model Builder, right-click the Root node and choose Add Study. 

2 The Add Study window opens in the Model Wizard. Under Preset Studies select 
Stationary . 

3 Click Finish .

STUDY 2

Step 1: Stationary
1 In the Model Builder, right-click Study 2  and choose Compute . 

RESULTS

The same default plots are generated as in “Results” on page 32. In this step, you edit 
the temperature plot to compare the results.

Temperature (nitf) 1
1 Under Results right-click Temperature (nitf)  and choose Arrow Volume .

2 In the Arrow Volume settings window click the Replace Expression  button. 

3 From the menu, choose Conjugate Heat Transfer (Laminar Flow)>Velocity field (u,v,w).
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4 Under Arrow Positioning:

- In the x grid points Points field, enter 20.

- In the y grid points Points field, enter 10.

- In the z grid points subsection from the Entry 
method list, select Coordinates.

- In the Coordinates field, enter 5e-3 or 5[mm].

5 Under Data from the Data set list, choose 
Solution 2.

6 Under Results, right-click Arrow Volume 1  and 
choose Color Expression .

7 In the Color Expression settings window click the 
Replace Expression button . 

8 From the menu, choose Conjugate Heat Transfer (Laminar Flow)>Velocity magnitude 
(nitf.U).

9 Click the Plot button . 

As a final step, pick one of the plots to use as a model thumbnail.

1 In the Model Builder under Results click Temperature (nitf) .

2 From the File menu, choose Save Model Thumbnail. 
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To view the thumbnail image, click the Root node and look under the Model Thumbnail 
section. Make adjustments to the image in the Graphics window using the toolbar 
buttons until the image is one that is suitable to your purposes.
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